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Chapter 1: Introduction
The Radiation Alert® Area Monitor is one of the most user friendly, all inclusive, state of the art radiation area 
monitors available. The easy to use interface is an intelligent resistive touch screen display featuring a large 5 
digit LED readout. 

It comes with either an internal or external detector and free software for monitoring every Radiation 
Alert® Area Monitor on your network. Includes user selectable warning indicators for low and high radiation 
alarm levels, low battery, and detector failure. All the settings are stored internally, even when power is 
disconnected.

Precautions
To keep the Area Monitor in good condition, handle it with care, and observe the following precautions:

• CAUTION: Never touch the Area Monitor or the external detector to a surface that may be contaminated. 
You may contaminate the instrument.

• Do not get the Area Monitor wet. Water can damage the circuitry.
• Do not put the Area Monitor in a microwave oven. It cannot measure microwaves, and you may damage 

it or the oven.
• This instrument may be sensitive to and may not operate properly in radio frequency, microwave, 

electrostatic, and high electromagnetic fields. 
• In the event of exposure to high static discharge, which may result in the screen going blank, please 

restart the unit to resume normal funtion. 
• Do Not connect or disconnect an external probe to the base unit while the Area Monitor is powered on. 
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Chapter 2: Quick Start

1.  If you are using an external detector, ensure that the 
unit is powered off before connecting the detector to the Area 
Monitor with the included C to C cable.  (If your Area Monitor has 
an internal detector, skip this step and proceed to step 2.) Note the 
Maximum Cable Lengths for GM Probes is 100ft and for  Scintillation 
Probes is 50ft

2. Connect the included +12VDC power supply into the right 
side of the Area Monitor, located to the left of the power switch. 
Then plug the power supply into an electrical outlet.

3. Once you have connected the probe and power, change the 
Power switch to the ON position. The power switch is located on 
the bottom of the Area Monitor to the left of the Ethernet jack.

4. The Area Monitor will quickly go to the start up screen 
while the system boots up. It will take approximately 30 seconds to 
finish the boot process.

5. After the boot process has been completed, the main 
screen will be displayed and the Area Monitor is now operational. 
The display will update to show the current radiation rate within a 
few seconds. 

7. To silence or acknowledge any alarm, tap the “ALARM” 
button that appears towards the lower center of the screen when 
an alarm has been triggered.

6. To see details of the system set up, tap the “System…” 
button on the touch-screen display.
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The General Operation Screens
The Radiation Alert® Area Monitor has two separate screens for general operation of the unit; The Main Screen 
and the System Info Screen. In order to enter the System Settings, press "System". The Default Passkey is 1234.

The Main Screen Figure 3(1)

The Main Screen is divided into two general sections.  The top 
two thirds displays the current radiation rate.  The lower section 
displays the units used, voltages of both the external power and 
the internal battery, and the “System…” button.  This area is 
also used to display alarm information and provide a button to 
acknowledge and/or silence current alarms.

The System Info Screen Figure 3(2)

Pressing the “System” button will open the system information 
screen. 

This screen displays several key system parameters.  They cannot 
be edited from this screen.  The upper right corner displays the 
current radiation rate. All alarms are still active and function as 
normal while this screen is displayed.

Press the “Back…” button to return to the main screen.

Display of Alarms Figure 3(3)

There are three alarm types: 
Hardware Fail Low High
Software Fail Radiation  

Warning
Critical Radiation 
Alert

The Fail condition occurs when the incoming count rate is lower than the entered set point, which is normally 
set to some fraction of the ambient background.  The Fail alarm indicates the Area Monitor is not functioning 
properly (e.g. the detector has failed or has been disconnected). To silence or acknowledge any alarm, tap the 
“ALARM” button that appears towards the lower center of the screen. Once the alarm has been acknowledged, 
the horn will stop and the strobe will continue to flash until the levels fall below the alarm set threshold. Note: 
By default, the fail alarm is deactivated. 

Chapter 3: General Operation

Figure 3(1)

Figure 3(2)

Figure 3(3)
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Chapter 4: Selecting Base Units of Measurement
The Set Base Unit Screen Figure 5(1) 

The Base Unit sets the units of measurment that will be used 
for the Area Monitor display and the alarm set points.  From the 
calibration Settings screen, tap the “Base Unit…” button to open 
the Set Base Unit screen

Tap the radio button next to the desired Base Unit, and the 
displayed rate will immediately be converted to that unit. The 
displayed value updated within 2 seconds .  When finished, tap 
the “Back…” button to return to the Calibration Settings screen.

The Base Unit also determines what MINIMUM subunit will be displayed.  For example, if the base unit is mR/h 
and the radiation field on the detector is 80 µR/h, the displayed value will be 0.1 mR/h.

Figure 5(1)

DB-9 Relay Connector 

The Radiation Alert Area Monitor can interface with external 
triggers and external strobes/horns via the DB-9 relay connector, 
located on the bottom of the unit.  See “Appendix C: Relay and 
Triggers Technical Info” for more information.

Connecting The Remote Alarm

Connect the remote alarm with a standard serial cable by 
plugging the female end of the cable into the bottom of the area monitor and the male end into 
the bottom of the remote alarm. Once the unit is connected, you can set alarm response settings in the Set 
Alarm Indicators screen. Note: All alarm indicators can be modified directly on the Area Monitor or via the Area 
Monitor PC software.

To enter the set alarm indicators screen (Figure 6(2)), use the included pin, a paper clip, or another small 
object to press the recessed button on the bottom of the Area Monitor.  This will cause the Passkey Screen to 
display: Figure 4(1). Enter your passkey and select the set button, then select the Indicators button to open the 
Set Alarm Indicators screen. The strobe and siren settings only apply to the local unit. The relays control the 
remote alarm, and the remote alarm’s strobe and audio settings are built into the alarm.

Assigning any alarm to relay A will cause the audible alarm to sound and the strobe light to flash, without 
pause when triggered in the remote alarm. Relay A is generally intended for the high alarm.

Relay B will cause the audible alarm to cycle on and off for about one second each when triggered in the 
remote alarm.  The strobe will flash continuously. Relay b is generally intended for the low alarm.

Relay C will cause the audible alarm to make a short “blip” about once per second when triggered in the 
remote alarm.  The strobe will flash continuously. Relay C is generally intended for the fail alarm.

Chapter 5: Connecting Relays and Triggers

Figure 6(2)
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Chapter 6: Setting The Alarm Levels
The Set Alarm Levels Screen Figure 6(1) 

The Set Alarm Levels Screen is used to set the levels at which the 
three alarms are triggered.  From the Calibration Settings screen, 
tap the “Alarms…” button to open the Set Alarm Levels Screen.

Tap the radio button next to the alarm type to be set.  Use the 
keypad to enter the desired Alarm Level.  Any value, including 
fractional, may be entered.  The modified Alarm Level(s) will not 
be applied until the “Set” button is tapped, at which point the 
display will return to the Calibration Settings screen.  Tap the “Back…” button instead to cancel any modified 
value(s) and return to the Calibration Settings screen.

The Fail alarm sets the level below which an instrument failure is indicated.  The Low Alarm is intended for use 
as a warning level, and the High Alarm is intended as a true level of interest.

The units used for the Alarm levels are determined by the Base Unit setting.  If the Base Unit is changed the 
alarm settings will not be corrected.  For example, if an alarm level of 100 mR/h is set and then the base unit is 
changed to µR/h, the actual applied alarm value will become 100 µR/h.

Setting any Alarm Level to zero will disable that alarm.

NOTE: If you change the unit of measurement, you will need to reset your alarms with the current unit of 
measure.

The Set Indicators Screen Figure 6(2) 

The Set Indicators screen is used to set which annunciators are associated with the three alarms.  From the 
Calibration Settings screen, tap the “Indicators…” button to open 
the Set Indicators screen.

For each alarm type, tap the associated radio buttons to trigger 
one of three relays (accessible through the DB9-M connector on 
the bottom of the Area Monitor), utilize the strobe light on the 
front of the Area Monitor, and to set the siren to sound fully, 
use an intermittent pattern (1 second on, 1 second off), or be 
disabled.

The modified Alarm Indicators will not be applied until the “Set” button is tapped, at which point the display 
will return to the Calibration Settings screen. Tap the “Back…” button instead to cancel any modified value(s) 
and return to the Calibration Settings screen.  

For information about setting up text and email alerts for your alarms, please refer to the  “How to Send Alerts 
Via Email and Text Message” section on page 12 of Chapter 8.

Figure 6(1)

Figure 6(2)
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Chapter 7: Ethernet Configuration
The Set Communications Screen Figure 7(1) 

In addition to the touch screen interface, the Area Monitor 
can communicate with a PC using USB and/or Ethernet and 
the included Area Monitor PC Software.  From the Calibration 
Settings screen, tap the “Comms…” button to open the Set 
Communications screen.

Tap the appropriate radio button to enable the Ethernet and or 
Serial (USB) functionality.  For Ethernet, the IP address of the PC 
to which data will be sent must be specified on this screen.  The modified Communications Settings will not be 
applied until the “Set” button is tapped, at which point the display will return to the Calibration Settings
screen.  Tap the “Back…” button instead to cancel any modified value(s) and return to the Calibration Settings
screen. 

Figure 7(1)

The Area Monitor Server Software enables users to remotely monitor and configure the Radiation Alert Area 
Monitor via USB or Ethernet, view the area monitors in real time,  export collected data, and change the 
settings of the unit. 

Installing the Area Monitor Server PC Software
There is no additional charge for the Area Monitor Server Software. It can be downloaded at seintl.com/area_
monitor_software. Once you have downloaded the installer to the PC you would like to install the software on, 
double click the exe file to begin your software installation. Follow the on-screen prompts until the install is 
complete. 

Area Monitor Server Software Menu Items

File Menu

Exit
To exit the software, click EXIT in the File Menu. 

View Menu

Floor Plan
To load an image of your floor plan, go to View > Floor Plan to open the Floor Plan window. From here, you can 
place the area monitors listed in the main window of the Area Monitor Server Software on a customized map 
you can load into the software. Accepted file formats for floor plan images are jpg (jpeg), png, bmp, and tiff 
files. 

Chapter 8: Area Monitor PC Software
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Lost Connection Status. Once it has lost a connection, you can hide it from being 
displayed in the main screen.

Server IP Address
Shows the IP address for the computer with the Area Monitor Server Software installed.

Hide Unconnected
In the event that you have lost a network connection or change the serial number of the area monitor 
connected to the software, the Area Monitor Server will lose the connection to the previous serial number of 
the area monitor and create a new area monitor in the software window. After a unit fails on the network, or 
the network connection to the unit fails, it take approximately 5-10 seconds for the area monitor software to 
register the lost connection. If you changed the serial number of the area monitor, the previous settings will 
appear as an area monitor that has a lost connection. To remove the one listed with the older settings, go to 
View > Hide Unconnected.

Calibration and Settings
The Calibration and Settings screen is used to 
change the High Voltage, Threshold, Dead Time, Cal 
Constant, IP Address, Alarms, Units, Serial Number, 
and Communication settings. 

You can access the Calibration and Settings Screen 
two ways. For both, select the row in which the 
area monitor is listed in the main window. An arrow 
to the left side of the row will indicate you have 
selected the correct unit. 

1) Select View > Calibration and Settings

2) Right Click on the row and then click on 
Calibration and Settings.

NOTE: Be sure to set your unit of measurement first. When changing units of measurement, if you have 
already set the alarm levels, then the same numeric value will be assigned to the new unit of measurement. 
For example, if the alarm level is set at 300 CPM (Counts Per Minute) and then the units of measurement are 
changed to mR/hr, then the alarm setting will change to 300 mR/hr. The numeric value stays the same, but 
the unit of measurement changes. NOTE: If you change the unit of measurement, you will need to reset your 
alarms with the current unit of measure.
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Help Menu

Open Help File 
Opens a searchable help file for answering basic questions about the use of the software.

About RSA Area Monitor Server Software
Opens a window that shows the version number of the software, technical support contact, and the location of 
the files on your computer that are created when each new area monitor is added or changed in the software.

View Detail Window

The View Detail Window displays a histogram of the 
collected data, the current count rate, the status of 
the connection, the serial number, and the IP address 
of the unit.  It is also used as a means of collecting 
data, setting the data logging frequency, and exporting 
the data received from the area monitor to a text file. 
You can also select how frequently to log the data in 
the Data Options menu, located in the lower right 
corner of the View Detail screen. 

Exporting Data

You can select the last hour, the last day, the last week, or the last month to export, as well as custom date 
ranges to export. Exporting data is located at the bottom of the View Detail screen just below the data options. 

Loading a Floor Plan

To load an image of your floor plan into the Area Monitor Server 
Software, open View > Floor Plan to open the floor plan window. 

Click the Load Floor Plan Image button, select the image of your 
floor plan, and click Open.

You will now see your floor plan image in the floor plan window. 
There will also be green square icons (connected area monitors) or 
purple square icons (lost connection) that represent each monitor 
on the network. To drag them to the proper position on the floor 
plan map, scroll over the small box in the upper left corner of each 
icon and hold down the mouse button to drag them to the desired 
position on the floor plan map. Once you have placed them where 
you want them on the floor plan, check the Lock Monitor Locations 
check box in the upper left of the Floor Plan window. This will 
ensure that the locations of the area monitors on the floor plan 
map will not be moved accidentally. 
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Deleting Units from the Area Monitor Server Software Permenently

In order to permanently delete any old area monitors in the Area Monitor Server window, you will need to de-
lete the configuration files created by the software on your computer. To do this, go to the Help menu and click 
About. The about screen will contain the location of the folder on your computer where all of the configuration 
files are stored. Click on the address located at the bottom of the about screen titled “User Data Location”. This 
will open the folder and you will see the various folders created by the Area Monitor Server software for each 
monitor on your network.

Delete any of the folders you want to permanently remove from the area monitor list, along with the GuiState 
file. Empty the recycle bin and restart the Area Monitor Server software. 

Acknowledging Alarms and Warnings

In the event that an area monitor alarm or warning, the corresponding row in the main screen will show the 
state of the event in the status column. When the status of an alarm becomes active, the user can acknowl-
edge the alarm by clicking the Acknowledge button to the right of the alarm status. 

Once you have Acknowledged an alarm from the Area Monitor Server Software screen, the area monitor horn 
will stop at the unit location and the button state will change to Acknowledged in the software. If the rate 
drops below the alarm level, then the alarm will reset and the strobe will stop. This means that if the alarm is 
triggered and acknowledged and the alarm goes off again, the rate has dipped below the alarm threshold and 
has risen above the alarm level again. In other words, the rate is hovering around the set alarm level. 

The Status has five different states; OK, Monitor Failure Detected, Radiation Warning, Critical Radiation Alert, 
and Lost Communication. 

Monitor Failure Detected
In the event that the area monitor reaches the threshold set for the monitor failure, the Monitor Failure Alarm 
will appear in the status column of the software.

Radiation Warning prior to Acknowledge button click

Radiation Warning after Acknowledge button click
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Radiation Warning (Low Alarm on the Touch Screen)
The Radiation Warning is the low alarm threshold. When the rate gets above the set Radiation Warning, the 
unit will respond with the settings used in the Set Alarm Indicators. 

Critical Radiation Alert (High Alarm on the Touch Screen)
The Critical Radiation Warning is the high alarm threshold. When the rate gets above the set High Alarm, the 
unit will respond with the settings in the Set Alarm Indicators. 

Lost Communication
In the event that the area monitor has lost connection with the network and/or the area monitor server for a 
period of 10 seconds, the Lost Connection in the status window will appear. 

How to Send Alerts Via Email and Text Message
The Radiation Alert® Area Monitor has the ability to send alert messages via text or email in the event an alert 
is triggered. There are two different forms of alert settings. One for the software, which requires the software 
to be running on the computer connected to the Area Monitor. And one for the hardware, which programs 
the alert notifications to be sent directly into the Area Monitor itself, which does not require the software to 
be running at the time of the alert. Both require that the Area Monitor be connected to the network and have 
access to the internet. 

Software Alerts
To set the Software Alert, in the main window of the Area Monitor Server Software, click on the View menu 
and select “Software Alert Rules”.  This will open the Alert Rules window. The Alert Rules window enables the 
user to set up different responses to different alert levels and direct the notification to the appropriate person.  
By default, the first Rule Name is titled “Send Alert”, however, you can 
change the Rule Name to your desired setting.  

Setting Up To Send An Alert
1)  The “When Monitors” field  will list all of the Area Monitors connected to 
the server software. Select the Area Monitors that you would like to set up 
to send alerts. 

2)  Select the alert warnings for which 
you would like to recieve alerts under 
“Change Status To:”

3)  Enter the email address(es) you 
would like to recieve the notifications. If you would like to send a text 
instead of an email, use an SMS to email gateway. (For more information 
on SMS to email gateways, please refer to Appendix D on page 21.)

4)  By default, the Area Monitor Server Software uses the S.E. 
International mail servers to send an alert from AreaMonitorAlert@
seintl.com.  If you would like to configure the alerts to use your own 
email server, click “Configure Alert Sender” and enter the appropriate 
settings for your email server. 
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Hardware Alerts
To set the Hardware Alert, in the main window of the Area Monitor Server Software, click on the View menu 
and select “Calibration and Settings”.  From the Calibration and Settings window, click the “Hardware Alert 
Settings” to open the “Area Monitor Alerts” window. 

Where as the “Software Alert Rules” enable you to 
setup a number of alert rules, the hardware  “Area 
Monitor Alerts” enables you to configure a single 
alert rule that will be sent via the Area Monitor. 
However, unlike the “Software Alert Rules”, the 
Hardware Alerts do not require that the Area 
Monitor Server Software be running to send them. 
All that is required is for the Area Monitor to be 
plugged into your network and provided with 
internet access. 

Setting Up To Send An Alert
1)  Select the alert warnings for which you would 
like to recieve alerts under “When Monitor Chages 
Status To” by clicking the coresponding check box.

2)  In the “Send Emails To: text box, enter the email address(es) you would like to recieve the notifications. If 
you would like to send a text instead of an email, use an SMS to email gateway. (For more information on SMS 
to email gateways, please refer to Appendix D on page 21.)

3)  By default, the Area Monitor Server Software uses the S.E. International 
mail servers to send an alert from AreaMonitorAlert@seintl.com.  If you 
would like to configure the alerts to use your own email server, click 
“Configure Alert Sender” and enter the appropriate settings for your email 
server. 
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The Area Monitor Calibration Screens
The Radiation Alert® Area Monitor has five separate screens for 
calibration of the detector in use with the unit. Each of these 
can be accessed via the Calibration Settings Screen: The Set High 
Voltage Screen, The Set Threshold Screen, The Set Dead Time 
Screen, and The Set Cal Constant Screen. 

Accessing The Calibration Settings Screen Figure 4(2)

All calibration settings can be modified directly on the Area 
Monitor without requiring the use of the Area Monitor PC 
software.  To enter the calibration and settings screen, use a 
paper clip or other small object to press the recessed button on 
the underside of the Area Monitor.  This will cause the Passkey 
Screen to display. Figure 4(1)

Enter the passkey (default is 1234) then press the “Set” button.  
If the passkey is correct, the Calibration Settings screen will be 
displayed. (Note: the passkey can only be changed using the 
software, with the Area Monitor connected to the PC through the 
USB or Ethernet ports.) Figure 4(2)

The Set High Voltage Screen Figure 4(3)

From the Calibration Settings screen, tap the “High Voltage…” 
button to open the Set High Voltage screen.

Use the keypad to enter the desired high voltage.  Any values, 
including fractional, may be entered.  The modified high voltage 
setting will not be applied until the “Set” button is tapped, at 
which point the display will return to the Calibration Settings 
screen.  Tap the “Back…” button instead to cancel any modified 
value and return to the Calibration Settings screen.

Chapter 9: Calibration Settings

Figure 4(1)

Figure 4(2)

Figure 4(3)
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Note that the High Voltage has a maximum of 1200 volts.  If a value higher than this is set, 1200 V will instead 
be applied

The Set Threshold Screen Figure 4(4)

The threshold sets the minimum size a detector pulse must be, in units of mV, in order to be registered as a 
count.  From the calibration Settings screen, tap the “Threshold…” button to open the Set Threshold screen. 

Use the keypad to enter the desired threshold.  Any integer value may be entered.  The modified threshold 
setting will not be applied until the “Set” button is tapped, at which point the display will return to the 
Calibration Settings screen.  Tap the “Back…” button instead to cancel any modified value and return to the 
Calibration Settings screen.

The threshold can be set between 0 and 2000 mV .  If a value higher than 2000 mV is set, 2000 mV will instead 
be applied.

If the threshold is set too low, excessive counts (due to electronic noise) may occur.  If it is too high, counts may 
be missed.  In gamma scintillation detectors, a threshold setting that is too high could also reduce the response 
to low-energy gamma radiation.  Generally, a setting of approximately 50 mV is appropriate.

The Set Dead Time Screen Figure 4(5)

Dead time is used to correct count rates for pulses that are 
“missed” due to pile up (in the case of scintillation detectors) 
or from gas recombination time (in the case of GM detectors).  
Dead-time correction keeps responses linear over the entire 
useful range of radiation intensities.  From the Calibration 
Settings screen, tap the “Dead Time…” button to open the Dead 
Time screen.

Use the keypad to enter the desired dead time.  Any value, 
including fractional, may be entered.  The modified dead time setting will not be applied until the 
“Set” button is tapped, at which point the display will return to the Calibration Settings screen.  Tap the 
“Back…” button instead to cancel any modified value and return to the Calibration Settings screen.

There are no restrictions on values to which the dead time can 
be set.  However, note that the absolute maximum count rate 
that can be displayed is equal to 1/dead time.  

Generally, scintillation detectors have dead times in the range of 
1 to 4 µSec while GM tubes have dead times in the range of 10 to 
100 µSec.

Setting the Dead Time to zero will disable dead-time correction. Figure 4(5)

Figure 4(4)
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The Set Cal Constant Screen Figure 4(6)

The Calibration Constant is a conversion factor used to convert 
the detector’s count rate into units of exposure or dose rate.  
From the calibration Settings screen, tap the “Cal Constant…” 
button to open the Set Cal Constant screen. 

Use the keypad to enter the desired Cal Constant.  Any value, 
including fractional, may be entered.  The modified Cal Constant 
setting will not be applied until the “Set” button is tapped, at 
which point the display will return to the Calibration Settings 
screen.  Tap the “Back…” button instead to cancel any modified value and return to the Calibration 
Settings screen.

The Cal Constant is usually determined by exposing the detector to a known radiation field (in units of mR/h) 
of about 10 to 20% of the maximum value the detector is capable of detecting, noting the count rate in cps, 
and dividing cps by mR/h.

The Set Calibration Date Screen Figure 4(7)

The Calibration Date is used to set the Cal Date displayed in the 
System screen.  From the calibration Settings screen, tap the “Cal 
Date…” button to open the Set Calibration Date screen.

Use the keypad to enter the Calibration Date.  Any value may be 
entered and no checking is performed regarding format.  The 
modified Calibration Date will not be applied until the “Set” 
button is tapped, at which point the display will return to the 
Calibration Settings screen.  Tap the “Back…” button instead to 
cancel any modified value and return to the Calibration Settings 
screen.

Setup and Calibration Sequence
1. Disable alarms by setting all three alarm levels to zero. 
2. Set threshold and high voltage to appropriate values, generally with the Base Unit set to cpm or cps. 
3. Determine and set the Dead Time for the detector in use. 
4. Determine and set the Calibration Constant for the detector in use. 
5. Set the Base Unit to the desired minimum unit of measure. 
6. Confirm calibration by challenging with known levels of radiation and observing the indication. 
7. Set Alarm Levels, Alarm Indicators, and Communication Settings as desired. 
8. Set the Calibration Date.

Figure 4(6)

Figure 4(7)
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Sensitivity, or Calibration Constant, is expressed in cps per mR/hr (Counts Per Second for every milliroentgen 
the detector can detect) referenced to Cs-137. Mathematically the cps units cancel each other out leaving mR/
hr, as shown below.

For example, if you have collected 200 CPS with a GM tube that has a typical gamma sensitivity of 60 cpm per 
mR/hr, you would divide the 200 cps by the 60 cpm per mR/hr sensitivity. The cps cancels out and you are left 
with 200/60 mR/hr = 3.33 mR/hr (Note, however, that the Area Monitor performs this conversion internally.)

= cps
cps

mR/hr

cps
1

XmR/hr
cps

= mR/hr

Radiation Measurement Units
Several different units are used to measure radiation, exposure and dosage.

Roentgen is the amount of X-radiation or gamma radiation that produces one electrostatic unit of charge in 
one cc of dry air at 0° C and 760 mm of mercury atmospheric pressure. One thousand milliroentgen (1,000 
mR)= 1R. The Area Monitor can also displays in microroentgens per hour (millionths--µR/h),  milliroentgens per 
hour (throusandths--mR/hr) and kiloroentgens per hour (thousands—kR/h). 

Rad is the unit of exposure to ionizing radiation equal to an energy of 100 ergs per gram of irradiated material. 
This is approximately equal to 1.07 roentgen.

Rem is the dosage received from exposure to a rad. It is the number of rads multiplied by the quality factor of 
the particular source of radiation. The rem and millirem are the most commonly-used measurement units of 
radiation dose in the U.S. 1 rem= 1 rad.

Sievert is the standard international measurement of dose. One sievert is equivalent to one hundred rems. A 
microsievert (μSv) is one millionth of a sievert. A unit of dose equivalent. 1 Sv= 100 roentgens, 10 µSv/hr = 1 
milliroentgen/hr.

Curie is the amount of radioactive material that decays at the rate of 37 billion disintegrations per second, 
approximately the decay rate of one gram of radium. Microcuries (millionths of a curie) and picocuries 
(trillionths of a curie) are also often used as units of measurement.

Becquerel (Bq) is defined as the activity of a quantity of radioactive material in which one nucleus decays per 
second. 1 dps (one disintegration per second).

Converting CPS to mR/hr

mR/hr = cps
sensitivity

200 cps
cps

mR/hr

= 3.33 mR/hr
60

Chapter 10: Unit Conversions
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Background Radiation
Naturally occurring radiation is always present. It includes high energy gamma rays and particles from the sun 
and outer space and alpha, beta, and gamma radiation emitted from elements in the earth.

CPM (counts per minute)
The unit of measurement usually used to measure alpha and beta radiation.

Ion
An atomic particle, atom, or molecule that has acquired an electrical charge, either positive or negative, by 
gaining or losing electrons.

Ionization
The process by which neutral atoms of molecules are divided into pairs of oppositely charged particles known 
as ions.

Ionizing Radiation
Radiation capable of producing ionization by breaking up atoms or molecules into charged particles called ions.

Radiation
The emission and propagation of energy through space or through matter in the form of particles or waves.

Radionuclide
The naturally occurring or artificially produced radioactive form of an element.

Decay
When an atom emits an alpha or beta particle or a gamma ray, it becomes a different type of atom. Radioactive 
substances may go through several stages of decay before they change into a stable, or non-ionizing, form. For 
example; U-238 has 14 different stages of decay before it stabilizes. An element may have several forms, or 
isotopes. A radioactive isotope of an element may be called a radioisotope. However, the more correct term is 
radionuclide.

Half-life
Each radionuclide has a characteristic half-life, which is the time required for half of a quantity of the material 
to decay.

Chapter 11: Glossary of Common Terms
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Display:   
Approx. 4in by 2.2in resistive touch screen
Numeric Display:   
Five digits, numerals 1.35in tall
Operating Ranges
•	 AM-7149: 0.2 - 16,000 mR/hr (2.0 - 160,000 µSv/hr) Using an Internally Mounted LND 7149 Energy 

Compensated GM Detector. External mounting also available
•	 AM-7128: 15µR/hr – 200 mR/hr (0.2 - 2000 µSv/hr) Using an Internally Mounted LND 7128 Energy 

Compensated GM Detector. External mounting also available
•	 AM-71313: 0.1 to 1500 mR/hr (0.5 - 15,000 µSv/hr) Using an Internally Mounted LND 71313 Energy 

Compensated GM Detector. External mounting also available
•	 AM-1X1NAI: 1 µR/hr to 10 mR/hr (0 µSv/hr – 0.1 mSv/hr) Using an Externally Mounted 1X1 NaI(Tl) 

Scintillation Probe
•	 AM-2X2NaI: 0.1 µR/hr to 2 mR/hr (0 – 20 µSv/hr) Using an Externally Mounted 2X2 Nal(Tl) Scintillation 

Probe
Maximum Cable Lengths:
GM Probes - 100ft, Scintillation Probes - 50ft 
High Voltage:  
Adjustable from 200 to 1200 Volts in increments of 0.1 V 
Threshold:  
Adjustable from 0 to 2000 mV in increments of 1 mV 
Dead Time:   
Adjustable in increments of 0.01 uSec
Calibration Constant:   
Infinitely adjustable in increments of 0.001 cps per mR/h
Base Units:   
µR/h, mR/h, µSv/h, mSv/h, cpm, kcpm, cps, and kcps
Autorange:   
Will not go below base selected base unit 
Averaging Time:  
Automatic based on incoming count rate, from 4 to 20 seconds:
Greater than 400 cps, averaging time = 2 sec
201 to 400 = 4 sec
101 to 200 = 6 sec
68 to 100 = 8 sec
51 to 67 = 10 sec
41 to 50 =12 sec 
35 to 40 =14 sec
30 to 34 =16 sec
26 to 39 =18 sec
Less than 25 = 20 sec
Power:   
External 12VDC
Battery:   
Internal SLA battery, will run unit for approximately 7.5 hours at background
Communications:   
USB, Ethernet
Supported Detectors:  
GM, Energy-Compensated GM, NaI, CsI, LaCl, LaBr, and all other scintillation detectors

Appendix A: Technical Specifications
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WARRANTOR: S.E. International, Inc., P.O. Box 39, 436 Farm Road, Summertown, TN 38483-0039, USA, (931) 
964-3561

ELEMENTS OF LIMITED WARRANTY: S.E. International, Inc., warrants for 1 year the included detector and for 1 
year all materials and craftsmanship in this product to be free from all defects with only the limitations set out 
below.

WARRANTY DURATION: The warranty shall terminate and be of no further effect one year after the original 
date of purchase of the product or at the time the product is: a) damaged or not maintained as is reasonable 
or necessary, b) modified, c) repaired by someone other than the warrantor for a defect or malfunction 
covered by this Warranty, d) contaminated with radioactive materials, or e) used in a manner or purpose 
for which the instrument was not intended or contrary to S.E. International, Inc.’s written instructions. This 
warranty does not apply to any product subjected to corrosive elements, misuse, abuse, or neglect.

STATEMENT OF REMEDY: In the event that the product does not conform to the warranty at any time while this 
warranty is effective, the Warrantor will repair the defect and return the instrument to you prepaid, without 
charge for parts or labor.

NOTE: While the product will be remedied under this warranty without charge, this warranty does not cover or 
provide for the reimbursement or payment of incidental or consequential damages arising from the use of or 
the inability to use this product. The liability of the company arising out of the supplying of this instrument, or 
its use, whether on warranties or otherwise, shall not in any case exceed the cost of correcting defects in the 
instrument, and after the said one year period all such liability shall terminate. Any implied warranty is limited 
to the duration of the written warranty.

PROCEDURE FOR OBTAINING PERFORMANCE OF WARRANTY: In the event that the product does not conform 
to this warranty, please write or call to the address above. S.E. International, Inc. will not accept contaminated 
instruments for calibration or repair under warranty or otherwise.

NOTE: Before using this instrument, the user must determine the suitability of the product for his or her 
intended use.

Appendix B: Limited Warranty
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DB-9 Relay Connector 

The Radiation Alert Area Monitor can interface with external triggers and external strobes/horns via the relay 
connector, located on the bottom of the unit. The connector can accomodate three seperate relays via the one 
connector. The corresponding pins for each three pin relay connection are detailed below. 

Each relay is a switch, and can be set as an indicator for any of 
the alarm states.  As an example, presume that Relay C has been 
assigned to the Failure Alarm.  When there is no current failure 
alarm, there will be an open connection (i.e. an open switch) 
between pins 6 and 1, and a closed connection (i.e., a closed 
switch) between pins 6 and 2.  If a failure alarm occurs these 
switches will be reversed:  there will now be a closed connection 
between pins 6 and 1, and an open connection between pins 6 and 2.

Appendix C: Relays and Triggers Technical Info

To send a text message via email, you must use an SMS to email gateway. Just substitute a 10-digit cell number 
for ‘number’ for each carrier below:

    AT&T: number@txt.att.net
    T-Mobile: number@tmomail.net
    Verizon: number@vtext.com
    Sprint: number@messaging.sprintpcs.com or number@pm.sprint.com
    Virgin Mobile: number@vmobl.com
    Tracfone: number@mmst5.tracfone.com
    Metro PCS: number@mymetropcs.com
    Boost Mobile: number@myboostmobile.com
    Cricket: number@sms.mycricket.com
    Nextel: number@messaging.nextel.com
    Alltel: number@message.alltel.com
    Ptel: number@ptel.com
    Suncom: number@tms.suncom.com
    Qwest: number@qwestmp.com
    U.S. Cellular: number@email.uscc.net

Appendix D: How to Send a Text Message Via Email

Relay A
Common = pin 5
Normally Open = pin 4
Normally Closed = pin 9

Relay B
Common = pin 3
Normally Open = pin 7
Normally Closed = pin 8

Relay C
Common = pin 6
Normally Open = pin 1
Normally Closed = pin 2
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Or fill out the form online at 
http://seintl.com/calibrations/	

NAME MODEL NAME

COMPANY SERIAL NUMBER

ADDRESS

CITY

STATE, ZIP, & COUNTRY PHONE NUMBER

Please fill out this form and send it back to us if you would like to be  
notified of the NIST calibration renewal for your instrument to: 

S.E.	International,	Inc.
P.O. Box 39, 436 Farm Rd. Summertown, TN 38483

1.800.293.5759 | 931.964.3561 | Fax: 1.931.964.3564
www.seintl.com | radiationinfo@seintl.com

EMAIL

DATE PLACED IN SERVICE

Calibration Database Application


